Chapter 515

Non-Inferiority Tests for the Ratio of Two Means in a 2x2 Cross-Over Design (Log-Normal Data)

Introduction

This procedure calculates power and sample size of statistical tests for non-inferiority tests from a 2x2 cross-over design. This routine deals with the case in which the statistical hypotheses are expressed in terms mean ratios rather than mean differences.

The details of testing the non-inferiority of two treatments using data from a 2x2 cross-over design are given in another chapter and they will not be repeated here. If the logarithms of the responses can be assumed to follow the normal distribution, hypotheses about non-inferiority stated in terms of the ratio can be transformed into hypotheses about the difference. The details of this analysis are given in Julious (2004). They will only be summarized here.

Non-Inferiority Testing Using Ratios

It will be convenient to adopt the following specialized notation for the discussion of these tests.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PASS Input/Output</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \mu_T )</td>
<td>Not used</td>
<td>Treatment mean. This is the treatment mean.</td>
</tr>
<tr>
<td>( \mu_R )</td>
<td>Not used</td>
<td>Reference mean. This is the mean of a reference population.</td>
</tr>
<tr>
<td>( M_{NI} )</td>
<td>NIM</td>
<td>Margin of non-inferiority. This is a tolerance value that defines the maximum amount that is not of practical importance. This is the largest change in the mean ratio from the baseline value (usually one) that is still considered to be trivial.</td>
</tr>
<tr>
<td>( \phi )</td>
<td>R1</td>
<td>Actual ratio. This is the value of ( \phi = \mu_T/\mu_R ) at which the power is calculated.</td>
</tr>
</tbody>
</table>

Note that the actual values of \( \mu_T \) and \( \mu_R \) are not needed. Only the ratio of these values is needed for power and sample size calculations.
When higher means are better, the hypotheses are arranged so that rejecting the null hypothesis implies that the ratio of the treatment mean to the reference mean is greater than one minus the margin of non-inferiority. The value of \( \phi \) at which power is calculated must be greater than \( \phi_0 = 1 - |M_{NI}| \).

\[
\begin{align*}
H_0 : \phi &\leq 1 - |M_{NI}| \quad \text{versus} \quad H_1 : \phi > 1 - |M_{NI}| \\
H_0 : \phi &\leq \phi_0 \quad \text{versus} \quad H_1 : \phi > \phi_0
\end{align*}
\]

When higher means are worse, the hypotheses are arranged so that rejecting the null hypothesis implies that the ratio of the treatment mean to the reference mean is less than one plus the margin of non-inferiority. The value of \( \phi \) at which power is calculated must be less than \( \phi_0 = 1 + |M_{NI}| \).

\[
\begin{align*}
H_0 : \phi &\geq 1 + |M_{NI}| \quad \text{versus} \quad H_1 : \phi < 1 + |M_{NI}| \\
H_0 : \phi &\geq \phi_0 \quad \text{versus} \quad H_1 : \phi < \phi_0
\end{align*}
\]

### Log Transformation

In many cases, hypotheses stated in terms of ratios are more convenient than hypotheses stated in terms of differences. This is because ratios can be interpreted as scale-less percentages, but differences must be interpreted as actual amounts in their original scale. Hence, it has become a common practice to take the following steps in hypothesis testing.

1. State the statistical hypotheses in terms of ratios.
2. Transform these into hypotheses about differences by taking logarithms.
3. Analyze the logged data—that is, do the analysis in terms of the difference.
4. Draw the conclusion in terms of the ratio.

The details of step 2 for the null hypothesis when higher means are better are as follows:

\[
H_0 : \phi \leq \phi_0 \quad \Rightarrow \quad H_0 : \frac{\mu_T}{\mu_R} \leq \phi_0 \quad \Rightarrow \quad H_0 : \ln(\mu_T) - \ln(\mu_R) \leq \ln(\phi_0)
\]

Thus, a hypothesis about the ratio of the means on the original scale can be translated into a hypothesis about the difference of two means on the logged scale.

### Coefficient of Variation

The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter is used to represent the variation in the data because of a unique relationship that it has in the case of log-normal data.

Suppose the variable \( X \) is the logarithm of the original variable \( Y \). That is, \( X = \ln(Y) \) and \( Y = \exp(X) \). Label the mean and variance of \( X \) as \( \mu_X \) and \( \sigma_X^2 \), respectively. Similarly, label the mean and variance of \( Y \) as \( \mu_Y \) and \( \sigma_Y^2 \), respectively. If \( X \) is normally distributed, then \( Y \) is log-normally distributed. Julious (2004) presents the following well-known relationships between these two variables

\[
\begin{align*}
\mu_Y &= e^{\mu_X + \frac{\sigma_X^2}{2}} \\
\sigma_Y^2 &= \mu_Y \left( e^{\sigma_X^2} - 1 \right)
\end{align*}
\]
From this relationship, the coefficient of variation of $Y$ can be found to be

$$COV_Y = \frac{\sqrt{\mu_Y^2 (e^{\sigma_X^2} - 1)}}{\mu_Y} = \sqrt{e^{\sigma_X^2} - 1} = \sqrt{e^{\sigma_W^2} - 1}$$

where $\sigma_W^2$ is the within mean square error from the analysis of variance of the logged data. Solving this relationship for $\sigma_X^2$, the standard deviation of $X$ can be stated in terms of the coefficient of variation of $Y$ as

$$\sigma_X = \sqrt{\ln(COV_Y^2 + 1)}$$

Similarly, the mean of $X$ is

$$\mu_X = \ln\left(\frac{\mu_Y}{\sqrt{COV_Y^2 + 1}}\right)$$

Thus, the hypotheses can be stated in the original ($Y$) scale and then power can be analyzed in the transformed ($X$) scale.

**Power Calculation**

As is shown above, the hypotheses can be stated in the original ($Y$) scale using ratios or the logged ($X$) scale using differences. Either way, the power and sample size calculations are made using the formulas for testing the equivalence of the difference in two means. These formulas are presented in another chapter and are not duplicated here.

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and power.

**Solve For**

This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either *Power* for a power analysis or *Sample Size* for sample size determination.
Higher Means Are

This option defines whether higher values of the response variable are to be considered better or worse.

The choice here determines the direction of the non-inferiority test.

If Higher Means Are Better the null hypothesis is $H_0: R \leq 1-\text{NIM}$ and the alternative hypothesis is $H_1: R > 1-\text{NIM}$. If Higher Means Are Worse the null hypothesis is $H_0: R \geq 1+\text{NIM}$ and the alternative hypothesis is $H_1: R < 1+\text{NIM}$.

Power and Alpha

Power

This option specifies one or more values for the probability of a type-II error (beta). A type-II error occurs when you fail to reject the null hypothesis of inferiority when in fact the treatment mean is non-inferior.

Values must be between zero and one. Historically, the value of 0.20 was often used for beta. Recently, the standard has shifted to 0.10.

Power is defined as one minus beta. Power is equal to the probability of rejecting a false null hypothesis. Hence, specifying the beta error level also specifies the power level. For example, if you specify beta values of 0.05, 0.10, and 0.20, you are specifying the corresponding power values of 0.95, 0.90, and 0.80, respectively.

Alpha

Specify one or more values of alpha. Alpha is the probably of a type-I error. A type-I error occurs when you reject the null hypothesis of inferiority when in fact the treatment group is not inferior to the reference group.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as $0.01 \ to \ 0.10 \ by \ 0.01$.

Sample Size

N (Total Sample Size)

This option specifies one or more values of the sample size, the number of individuals in the study (total subjects in both sequences). This value must be an integer greater than one.

When N is even, it is split evenly between the two sequences. When N is odd, the first sequence has one more subject than the second sequence.

Note that you may enter a list of values using the syntax $50,100,150,200,250 \ or \ 50 \ to \ 250 \ by \ 50$.

Effect Size – Ratios

NIM (Non-Inferiority Margin)

This is the magnitude of the margin of non-inferiority. It must be entered as a positive number.

When higher means are better, this value is the distance below one for which the mean ratio (Treatment Mean / Reference Mean) still indicates non-inferiority of the treatment mean. E.g., a value of 0.2 here specifies that mean ratios greater than 0.8 indicate non-inferiority of the treatment mean.

When higher means are worse, this value is the distance above one for which the mean ratio (Treatment Mean / Reference Mean) still indicates non-inferiority of the treatment mean. E.g., a value of 0.2 here specifies that mean ratios less than 1.2 indicate non-inferiority of the treatment mean.
**R1 (Actual Ratio)**

This is the value of the ratio of the two means (Treatment Mean / Reference Mean) at which the power is to be calculated.

Often, the ratio will be set to one. However, some authors recommend using a ratio slightly different than one, such as 0.95 (when higher means are "better") or 1.05 (when higher means are "worse"), since this will require a larger sample size.

---

**Effect Size – Coefficient of Variation**

**COV (Coefficient of Variation)**

The coefficient of variation is the ratio of the standard deviation and the mean (SD/Mean). It is used to specify the variability (standard deviation). Note that this COV is defined on the original (not logarithmic) scale. This value must be determined from past experience or from a pilot study.

To be clear, consider the following definition. Suppose data on a response variable Y are collected. This procedure assumes that the values of $X = \text{Ln}(Y)$ are analyzed using an appropriate ANOVA procedure. Thus, there are two sets of means and standard deviations: those of X labelled $M_X$ and $S_X$ and those of Y labelled $M_Y$ and $S_Y$. The COV entered here is the COV of $Y = S_Y/M_Y$. For log-normal data, the following relationship exists: $\text{COV}(Y) = \text{SQR}(\text{Exp}(S_X*S_X)-1)$ where $S_X$ is the square root of the within mean square error in the ANOVA table of the log-transformed values.
Example 1 – Finding Power

A company has developed a generic drug for treating rheumatism and wants to show that it is not inferior to standard drug. A 2x2 cross-over design will be used to test the non-inferiority of the treatment drug to the reference drug.

Researchers have decided to set the margin of non-inferiority to 0.20. Past experience leads the researchers to set the COV to 1.50. The significance level is 0.05. The power will be computed assuming that the true ratio is one. Sample sizes between 50 and 550 will be included in the analysis.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Higher Means Are</td>
<td>Better (H1: R &gt; 1 - NIM)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Total Sample Size)</td>
<td>50 to 550 by 100</td>
</tr>
<tr>
<td>NIM (Non-Inferiority Margin)</td>
<td>0.2</td>
</tr>
<tr>
<td>R1 (Actual Ratio)</td>
<td>1.0</td>
</tr>
<tr>
<td>COV (Coefficient of Variation)</td>
<td>1.5</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Non-Inferiority Margin</th>
<th>Power</th>
<th>N</th>
<th>R0</th>
<th>R1</th>
<th>Alpha</th>
<th>Beta</th>
</tr>
</thead>
<tbody>
<tr>
<td>-NIM</td>
<td>0.26381</td>
<td>50</td>
<td>0.800</td>
<td>1.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td></td>
<td>0.55053</td>
<td>150</td>
<td>0.800</td>
<td>1.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td></td>
<td>0.74114</td>
<td>250</td>
<td>0.800</td>
<td>1.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td></td>
<td>0.85743</td>
<td>350</td>
<td>0.800</td>
<td>1.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td></td>
<td>0.92415</td>
<td>450</td>
<td>0.800</td>
<td>1.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td></td>
<td>0.96074</td>
<td>550</td>
<td>0.800</td>
<td>1.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
</tbody>
</table>
Non-Inferiority Tests for the Ratio of Two Means in a 2x2 Cross-Over Design (Log-Normal Data)

Report Definitions
Power is the probability of rejecting H0 when it is false.
N is the total sample size drawn from all sequences. The sample is divided equally among sequences.
-NIM is the magnitude and direction of the margin of non-inferiority. Since higher means are better, this value is negative and is the distance below one that is still considered non-inferior.
R0 is the corresponding non-inferiority margin bound and equals 1 - NIM.
R1 is the mean ratio (treatment/reference) at which the power is computed.
COV is the coefficient of variation on the original scale.
Alpha is the probability of falsely rejecting H0.
Beta is the probability of not rejecting H0 when it is false.

Summary Statements
A total sample size of 50 achieves 26% power to detect non-inferiority using a one-sided t-test when the margin of non-inferiority is -0.200, the actual mean ratio is 1.000, the significance level is 0.050, and the coefficient of variation on the original, unlogged scale is 1.500. A 2x2 cross-over design with an equal number in each sequence is used.

This report shows the power for the indicated scenarios. Note that if they want 90% power, they will require a sample of around 450 subjects.

Plot Section

This plot shows the power versus the sample size.
Example 2 – Validation

We could not find a validation example for this procedure in the statistical literature. Therefore, we will show that this procedure gives the same results as the non-inferiority test on differences—a procedure that has been validated. We will use the same settings as those given in Example 1. Since the output for this example is shown above, only the output from the procedure that uses differences is shown below.

To run the non-inferiority test on differences, we need the values of NIM and Sw.

\[
NIM' = \ln(1 - NIM) \\
= \ln(0.8) \\
= 0.223144
\]

\[
Sw = \sqrt{\ln(COV_T^2 + 1)} \\
= \ln(1.5^2 + 1) \\
= 1.085659
\]

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for the Difference Between Two Means in a 2x2 Cross-Over Design procedure window. You may then make the appropriate entries as listed below, or open Example 2b by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Higher Means Are</td>
<td>Better (H1: Diff &gt; -NIM)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Total Sample Size)</td>
<td>50 to 550 by 100</td>
</tr>
<tr>
<td>NIM (Non-Inferiority Margin)</td>
<td>0.223144</td>
</tr>
<tr>
<td>D1 (Actual Difference to Detect)</td>
<td>0</td>
</tr>
<tr>
<td>Standard Deviation Input Type</td>
<td>Sw (Sqrt[Within MSE from RM ANOVA])</td>
</tr>
<tr>
<td>Sw</td>
<td>1.085659</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>-NIM Difference</th>
<th>Actual Difference</th>
<th>Sw</th>
<th>Alpha</th>
<th>Beta</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.26381</td>
<td>50</td>
<td>-0.223</td>
<td>0.000</td>
<td>1.086</td>
<td>0.050</td>
<td>0.73619</td>
</tr>
<tr>
<td>0.55053</td>
<td>150</td>
<td>-0.223</td>
<td>0.000</td>
<td>1.086</td>
<td>0.050</td>
<td>0.44947</td>
</tr>
<tr>
<td>0.74114</td>
<td>250</td>
<td>-0.223</td>
<td>0.000</td>
<td>1.086</td>
<td>0.050</td>
<td>0.25886</td>
</tr>
<tr>
<td>0.85743</td>
<td>350</td>
<td>-0.223</td>
<td>0.000</td>
<td>1.086</td>
<td>0.050</td>
<td>0.14257</td>
</tr>
<tr>
<td>0.92415</td>
<td>450</td>
<td>-0.223</td>
<td>0.000</td>
<td>1.086</td>
<td>0.050</td>
<td>0.07585</td>
</tr>
<tr>
<td>0.96074</td>
<td>550</td>
<td>-0.223</td>
<td>0.000</td>
<td>1.086</td>
<td>0.050</td>
<td>0.03926</td>
</tr>
</tbody>
</table>

You can compare these power values with those shown above in Example 1 to validate the procedure. You will find that the power values are identical.